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SubmitWolf

In order to be found on the Internet, a site needs to be submitted to search engines and directories.
SubmitWolf will save time by automatically submitting your site to the relevant search engines. To manually
submit your site to the search engines will take months of your precious time. SubmitWolf can accomplish the
same time consuming task in a matter of minutes! An easy to use submission wizard to is included to assist
with the submission process.

Please read the Submission rules and frequently asked questions BEFORE submitting your site. The
information in these sections may prevent your site from being banned from the search engines.
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Features Overview

Automated submission to hundreds of search engines and directories.♦ 

Automatic submission to the most appropriate category for each engine.♦ 

Improved category selection with a wider variety and more specific categories to
choose from.

♦ 

SPAM control. Filter out your search engine selections based on the number of spam
emails sent out by each engine.

♦ 

Submit your site with up to 50 concurrent connections at the one time. This feature
helps your submission run faster.

♦ 

Full browser emulation and cookie support.♦ 

Popup Help wizard.♦ 

Free engine updates for 12 months.♦ 

FREE e−mail and Live chat support.♦ 
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Program Versions

There are three versions of SubmitWolf 7: Demo version, standard version and the Enterprise
version.

SubmitWolf 7 Demo
In the demo version, submissions are restricted to the demo search engines. The demo
version is designed to give you a feel for what the product can do. The demo expires
after 15 days. If you require an extension of the demo, please contact support.

♦ 

SubmitWolf 7
This version is designed for the average user. Users are limited to submitting 5
different domains. This version is intended for a single user to promote their own web
sites.

♦ 

SubmitWolf 7 Enterprise / SEO Toolkit 2 Enterprise
The Enterprise edition is designed for users who wish to submit more than 5 domains
or for users who wish to submit URLs for third parties. This version can be used as
the basis of a submission service. The enterprise version has no restrictions on the
number of domains that can be submitted. SubmitWolf 7 Enterprise registration
requires the purchase of SEO Toolkit 2 Enterprise.

♦ 
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Licence information

SubmitWolf 7 can be used on one computer at a time only. The SubmitWolf 7 licence can be
transferred between computers once every thirty days. If you wish to use SubmitWolf
simultaneously on multiple computers, you will need to purchase an additional copy of the
software.

Usage of SubmitWolf is governed by an acceptable use policy. The policy can be viewed on
the Trellian website and is also listed in this manual under the Submission rules section.
Failure to abide by this policy can result in your licence being suspended or cancelled.
Cancelled users are not entitled to a refund.

Licence information 4



System Requirements

Operating Systems:
   Microsoft Windows 2000/XP/Vista

CPU/Processors:
   Intel Pentium I, II, III, IV, AMD or compatible

RAM/Memory:
   64Mb or greater
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Before Starting

If you access the Internet via a proxy server or require firewall authentication, you will need
to enter these settings in SubmitWolf's Options.

Click the SubmitWolf Options menu and select Settings to access the Firewall/proxy settings.

If you are using a software firewall, such as Zone Alarm, Norton Internet Security, or
Windows XP service pack 2 firewall, you will need to configure the firewall to allow
SubmitWolf to connect to the Internet.

SubmitWolf uses the http protocol which uses port 80. If you are having problems
configuring the firewall/internet protection software, please seek support from the relevant
software manufacturer.
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Registering

SubmitWolf 7 can be purchased via the Trellian website, stores or authorised resellers.

To purchase the software from the Trellian web site, click the Help menu of SubmitWolf 7
and select Register. Click on the "obtain registration key" link. This will open the order form
in a browser window.

Follow these steps to register SubmitWolf.

Step 1. − Select Register from the Help menu.

Step 2. − Enter your registration details. Note that registration details are case sensitive.
SubmitWolf 4, 5 or 6 serial numbers will NOT register SubmitWolf 7.

Software purchased from stores display the serial number in the CD jewel case. Use your
email address as the registration name.
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If you have lost your registration details, click the relevant link on the registration window,
and follow the instructions. Click the Next button to continue. If your registration details are
accepted, a thank you message is displayed

Step 3. − SubmitWolf will then start the Engine Subscription Wizard, which will download
the engines based on your selections. If you do not proceed with the wizard, the full program
features will not be available. See the Engine subscription section of the manual for more
information.
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Engine subscription wizard

The engine subscription wizard will download engines based on your selections. The wizard
will be automatically started when SubmitWolf is registered, or if you have clicked the
Subscribe button to change your preferences. This wizard can also be accessed by clicking the
SubmitWolf Options menu and selecting Settings.

Engines are automatically updated prior to each submission, so there is no need to run this
wizard to update the engines. Please note that SubmitWolf needs to be restarted after
downloading the engine updates.

When the wizard is displayed, click the Next button to continue, or Cancel to exit the
wizard.

1. 

If your website content is in English, then select the checkbox to subscribe to the
English language engines. This will download the English engines for submission.

2. 
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Select the country that your web site(s) are based in.

eg. If your site is based in France then select France from the list.
If your site is based in the US, select United States from the list.

NOTE: You may not force the submission to regionally specific engines if your site is
not related directly to the region. This includes submitting sites to country specific
engines if your site is unrelated to and/or outside the country.

3. 
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Select the checkboxes to subscribe to the Link Lists and multisubmit link farms.

This option is not recommended.

4. 

Manual engines cannot be automated for various reasons. If you do not wish to5. 
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submit to the manual engines, leave this option unselected.

The wizard will then download the engines.6. 

When the download has completed, restart SubmitWolf to reload the engines.7. 
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When SubmitWolf is restarted, the Engine update complete message will be
displayed.

8. 
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Settings

To change the settings for SubmitWolf, click on the Options menu and select Settings

Concurrent Connections:
SubmitWolf can submit to a number of sites concurrently. This means that the program can
send and receive information simultaneously. This setting defines how many concurrent
connections will be used. The maximum number of connections that can be used at any one
time is 50 for standard users and 1024 for Enterprise users.

Connection Timeout:
The length of time that SubmitWolf will wait before attempting to retry and/or abort an
unresponsive connection. The default value is 2000 milliseconds. If you are experiencing
frequent timeout errors or connection problems during a submission, try specifying a larger
value.

Request Delay:
The length of time that SubmitWolf will wait between requests. The default value is 5
seconds.

User Agent:
The user agent name to send in outgoing requests. This setting is for advanced users only and
can be left blank.

Automatically check for SubmitWolf updates:
Enables automatic update checking.
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Note: Updates are not automatically downloaded

Changing the software language

The language used by SubmitWolf can be changed via the Options menu.
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Program interface

SubmitWolf's functions are accessible via the toolbar buttons and the menus.

Submission Wizard

SubmitWolf includes a wizard to assist with URL submission. To access the wizard, click on
the Wizard button.

Popup help

SubmitWolf has a pop up help system embedded into the software. Click on a Help button to
open the help viewer. As you click on different tools, menu items, checkboxes and fields, the
help viewer will automatically display helpful information. To display information about a
button, move the mouse cursor over the button for a few seconds and the buttons function will
be displayed.
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Upgrading

SubmitWolf 7 will automatically update the engines prior to a submission or ranking check.

To download the latest program upgrade, select the Upgrade option from the File menu.
SubmitWolf will contact the upgrade server to check if there are any upgrades available.

To install the new version, click the Install button. To install at a later date, click the Cancel
button.
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Engine subscription renewal

SubmitWolf comes with 12 months free engine updates. The engines are used by SubmitWolf
for submission. After the 12 months has elapsed, you will be prompted to renew the engines.

The engine subscription can be renewed by clicking on the OK button, as an order form will
be launched in your web browser. Alternatively the engines can be renewed via this URL:
https://trellian−secure.vendercom.com/seotoolkit/pack.htm
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Support

Trellian provides FREE email support for SubmitWolf.

If you are experiencing a problem or have a question, contact the support department by
filling out the form at http://www.trellian.com/contact.htm.

We also offer a Live Chat service at http://www.trellian.com/livesupport.htm

Support hours are Mon − Fri, 9:00am − 5:00pm (Melbourne, Australia − Eastern Standard
Time)

Please include your registration details, and some basic information about your computer and
the operating system you are running. Before emailing support, please check the FAQ first, as
90% of all questions we receive are already answered on these pages. You can view the FAQ
by selecting FAQ from the Help menu.
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Using SubmitWolf

This chapter explains how to use SubmitWolf.
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Submission Rules

Most search engines have strict rules as to the type of sites and the number of submissions
they accept.

The use of SubmitWolf is governed by an Acceptable use policy as outlined below.

Please note that these policies are in place for a very good reason: the use of SubmitWolf
contrary to these policies will result in your IP address, URL or both being banned from many
search engines.

You may not use this program to SPAM search engines by submitting the same URL
multiple times.

1. 

You may not submit different URLs which are identical, or similar copies of the same
page on the same server. (Otherwise known as "mirror sites")

2. 

You may resubmit a URL if there is a significant change both to the URL title and
page content.

3. 

You may not modify the submission rules to force the listing of inappropriate sites for
a given engine.

4. 

You may not force the submission to regionally specific engines if your site is not
related directly to the region. This includes submitting sites to other country's engines
if your site is unrelated to and/or outside the country.

5. 

You may not submit more than one URL from the same site to search engines unless
the pages are unrelated or have significantly different content.

6. 

You must select the most appropriate category for your URL7. 

You may not use the non−Enterprise version of the Software as the basis for an URL
submission service or to submit third party sites.

8. 
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Frequently Asked Questions

Please read through this list of questions and answers, as misuse of SubmitWolf can result in
your site being ranked badly, rejected or even banned from the search engines.

Can I submit each page of my website?

No. Most engines specifically request that only the index page is submitted.
There are two reasons for this:

To prevent multiple submissions creating a large backlog of sites for
search engines to index. Some search engines have people manually
checking each website before it is listed, so submitting each page is
not necessary and will increase the size of the submission queue.

1. 

Most search engines will spider each page of your website anyway.2. 
Many search engines will delete your submissions and refuse to index your
site if you submit it multiple times.

What is search engine spam?

Search engine spam is defined as pages created deliberately to trick the
search engine into offering inappropriate, redundant, or poor−quality search
results. Examples of search engine spam are:

Submitting MLM (Multi Level Marketing eg. Make money fast!!!)
sites to inappropriate categories.

◊ 

Submitting domains that are for sale and offer no useful content◊ 
Submitting keyword stuffed websites◊ 
Submitting a mirror site◊ 
Submitting a website that redirects to another site◊ 
Submitting a website that uses a doorway page. A doorway page is
page created specifically for search engines and is optimized for
specific phrases that generate large amounts of traffic. Generally
these pages are totally unrelated to the site's content, hence the spam
categorization.

◊ 

Submitting machine generated web pages.◊ 
Submitting websites with offensive content to inappropriate
categories.

◊ 

Submitting websites that offer no content other than links to other
websites.

◊ 
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Search engines do not add these types of websites to their index, and many
engines will simply delete the submission or use algorithms to filter out such
websites.

Search engine spam causes problems for legitimate website owners. Some
engines review each submission manually and in these cases, the spam
submissions extend the waiting time for site reviews. Engines that experience
a large number of spam submissions will often implement a pay for inclusion
scheme, a manual log in or registration prior to submission, or simply no
longer accept any submissions at all.

What will prevent a search engine from indexing a website?

Many search engines cannot crawl sites that use frames, or sites that are
created using flash. Sites using frames should be converted to an unframed
site. CSS (cascading style sheets) can be used instead of frames.

Most search engines, including Google, cannot crawl pages that use "&=" as
a parameter in the URL. Websites that use dynamic URLS for user tracking,
must allow robots to crawl a website without requiring session IDs or URL
parameters.

Search engines cannot read/follow JavaScript links. Replace JavaScript links
with plain HTML links or place an additional section for HTML links on
your website if the JavaScript links are necessary.

Most search engines do not index IP addresses − you must submit a domain
name, not an IP address.

A search engine cannot index a website where the robots.txt file specifies a
disallow statement for that engine.

Can I submit a free hosting URL eg. Geocities?

Many search engines will not index sites that use free hosting URLs. eg.
Geocities, Freewebs, ISP hosting etc. due to their transient nature.
Examples of these URLs are:

http://www.myisp.com/~johnsmith
http://www.geocities.com/aaaaa/bbbbb/123456/
http://www.freewebs.com/sitename
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Most engines specifically request that only top level URLs are submitted, and
many request that no free hosting sites are submitted. This request is due to
free hosting sites being indexed, only to become dead links when the site
owner loses interest or the free hosting is terminated.

A top level URL is a URL with no subdirectories or page names specified.
eg. http://www.trellian.com

To ensure that your URL can be indexed by all engines, it is suggested that
you purchase your own domain name and web hosting.

How do I select an appropriate category for my website?

The category you select is important, as it dictates which search engines will
be submitted to, and the category your site will be listed under in directories.
If you select an inappropriate category, your site will be submitted to engines
that are inappropriate for your site. eg. submitting an Accountancy service
website to the Automotive / Cars category will result in the site not being
indexed, as Automotive search engines aren't looking to index accounting
websites.

If someone is looking for a company to do accounting, they won't be looking
in Automotive or Music search engines, they will be looking on business and
accounting related search engines.

The SubmitWolf categories are grouped logically. Please read the entire list
before selecting a category, as there may be a more suitable category further
down the list.

To select a category, you need to think what your website is mainly about.
eg. A site about cars would be in the Automotive category. A website selling
shopping cart software would be in the Internet / Software category. Even
though the Automotive industry may be able to use the shopping cart
software, the shopping cart website is not primarily car related.

If you need help selecting a category, contact support with your website's
URL and we will advise you of the most suitable category for your site.

What type of sites can be submitted to the Personal Home Pages category ?

The Personal Home Pages category is for personal sites, eg sites about John
Smith, John Smith's holiday photos, John Smith's family, John Smith's dog
etc. This category is not for commercial / business websites.
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Can I submit my website to different categories?

99% of engines specifically request that websites are submitted to ONE
category only.

You can select multiple categories for your site, however SubmitWolf will
select the category at the top of the list when submitting. If the top category is
not supported by an engine, SubmitWolf will then select the next category on
the list, and so on. For this reason it is very important to place the most
relevant category at the top of the list.

Submitting a URL to multiple categories in a directory or search engine will
result in the website or your IP address being banned from the search engine.

How often should I resubmit my website?

Many search engines request that you only submit your website once. These
engines are marked as "No resubmission" in SubmitWolf, and any attempts
to resubmit to them, will not be successful. This is to prevent multiple
submissions, which can result in bad ranking, rejection or banning by the
search engines. (see the first question on this page)
In addition, multiple submissions just create a large backlog of sites for
search engines to index, so it will take longer for your site to be indexed. If
you search for your website on a search engine or directory and it is indexed,
then it does not require a resubmission. Generally search engines do not
remove listings unless a site is non functional or if it violates the engine's
policies.

Link lists (FFA sites) can be submitted to on a daily basis. The oldest links
are replaced with the newly submitted links, meaning that your link can be
cycled off the list in a matter of hours. SubmitWolf automatically allows
multiple submissions to be made to the link lists. Link lists are not
recommended as they result in a large amount of spam emails being sent to
the email address used on the submission.

Why are some engines manual?

Manual engines cannot be submitted to automatically for various reasons
such as:
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Some search engines and directories, such as Lycos and Yahoo,
require the webmaster to register and respond to a confirmation
email, then log into the engine and finally submit the website.

◊ 

Most directories require the webmaster to browse through the
directory's category structure to find a suitable category, then submit
the website.

◊ 

Some engines require very specific information in order to submit the
website. eg. Do you accept Visa cards, which countries does your
business ship to? etc.

◊ 

Engines with very specific categories, e.g. Aromatic oils, French
poetry, Small town business directories, are also set to manual as
they are too detailed to add as a SubmitWolf category.

◊ 

The submission page requires a unique security code to be entered in
order to validate the submission. A different security code is
generated for each page visit, and is designed to prevent automated
submissions. Engines that receive a large number of spam or junk
submissions will often implement security codes.

In SubmitWolf, Manual engines are marked with a grey gear image.

◊ 

Why doesn't SubmitWolf submit to .......?

Many major engines only accept paid listings. e.g. Overture and Looksmart..
For paid inclusion into these engines, visit http://www.prioritysubmit.com

Other engines, such as Yahoo, require manual submissions(see above FAQ
item)

Why does SubmitWolf skip engines?

SubmitWolf will skip engines if your site is not appropriate for the
engine.

◊ 

Many engines have specific rules as to the type of sites they accept
for listing. If the data you have entered violates a rule for a given
engine, it will be skipped. For example, some engines do not accept
adult sites or gambling sites.

◊ 

Some engines only accept websites about a specific category. For
example, a Travel search engine will only accept Travel related
websites. If your website does not fall into the Travel category, the
engine will be skipped.

◊ 
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Some engines require that a site is in a specific language.◊ 

Some engines only accept commercial websites, some only accept
non commercial websites. If your website is commercial, ensure that
you select the Commercial option from the Site type drop down
menu in the URL details window.

◊ 

A number of engines are marked for manual submission for various
reasons such as:

The engine only accepts websites about a very specific
category that SubmitWolf does not list. eg. Aromatic oils,
Dobermans, ASP code etc,

⋅ 

The engine's submission process requires a constantly
changing password or code to be entered. eg. MSN

⋅ 

The engine only accepts websites from a specific region,
state or province.

⋅ 

◊ 

My website isn't in French and/or doesn't have a French domain. Can I submit my
website to the French search engines?

Generally to be accepted in a foreign search engine, your site must contain
information about the country, provide a service to residents of the country or
provide information that is useful to people residing in that country.
Many search engines and directories will not list foreign sites in order to
restrict their search engine to businesses within their own country.

For example, a website selling/advertising a house cleaning service in
America, is not relevant or useful to residents of France.

In addition, many search engines will only list sites in particular languages.
eg. German search engines will only accept German language sites.
SubmitWolf automatically restricts submissions to search engines in
countries that are not appropriate for your site.

Submitting inappropriate sites is considered as spamming, and can result in
your SubmitWolf licence being revoked. Spamming search engines in this
way leads to engines restricting submissions by requiring a unique security
code to be entered prior to accepting the submission, or even implementing a
pay per submission scheme.

I have submitted my site, so why hasn't it been added to an engine?

The time taken for your site to appear varies greatly. It may be instant, or it
may take several months depending on the engine. The submission pages on
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most engines will give you an approximation as to how long it will take for
your site to appear. Submitting your site to an engine does not guarantee that
it will be listed, some engines may ban your website if they receive multiple
submissions. Some engines review all submissions manually and the
administrators can add or reject your submission at their discretion without
notice. Many engines are now sending confirmation emails, that require an
action to be performed in order to index the website. Failing to comply with
the instructions in the email will result in the website submission being
ignored.

If you have any other questions, please contact the support team.
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Icon legend

The icon legend below explains the meaning behind the symbols used in SubmitWolf.
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Category Descriptions

The category you select is important, as it dictates which search engines will be submitted to,
and the category your site will be listed under in directories. If you select an inappropriate
category, your site will be submitted to engines that are inappropriate for your site. eg.
submitting an Accountancy service website to the Automotive / Cars category will result in
the submission being deleted, as Automotive search engines generally don't index accounting
websites.

If someone is looking for a company to do accounting, they won't be looking in Automotive
or Music search engines, they will be looking on business and accounting related search
engines.

The SubmitWolf categories are grouped logically. Please read the entire list before selecting a
category, as there may be a more suitable category further down the list.

To select a category, you need to think what your website is mainly about. eg. A site about
cars would be in the Automotive category. A website selling shopping cart software would be
in the Internet / Software category. Even though the Automotive industry may be able to use
the shopping cart software, the shopping cart website is not primarily car related.

If you need help selecting a category, contact support with your website's URL and we will
advise you of the most suitable category for your site.

Adult (sex)

Category Name Type of sites accepted

Image/ TGP Adult images and thumbnail gallery pages.

Film & Video Adult film and video related sites

CDs Adult CD Rom related sites

General Adult sites that are not covered by any other categories

Literature Adult related literature eg. books and other media.

Live Sex Video
Conferencing

Adult related Live video or webcams

Magazines Adult magazines

Merchandise and
equipment

Sex shops and other adult related merchandise not
covered by other categories

Phone Sex Phone sex services
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Services
Other adult related services not covered by other
categories eg. Escorts

Arts and humanities

Category Name Type of sites accepted

Art
Art related sites. Sites selling Art should be submitted to the
Consumer Products − Arts/crafts category.

Cultural Events Cultural events

General
General arts/humanities sites. Sites selling Art should be
submitted to the Consumer Products − Arts/crafts category

History History

Literature

Literature related sites. Adult/sex related literature should be
submitted to the Adult − Literature category. Magazines and
Newspapers should be submitted to the Media − Magazines
and Media − Newspapers categories.

Museums/Galleries
Museum and Gallery sites. Sites selling art/crafts should be
submitted to the Consumer Products −Art/Crafts category

Music

Hobby related music sites. Sites promoting music products
should be submitted to the Music/CD's or Music DVD's
category. Sites providing a music service should be submitted
to the Entertainment − music category.

Photography

Photography sites. Sites promoting photography services
should be submitted to the Business and services −
photography category. Sites selling photographs should be
submitted to the Consumer products − Arts/Crafts category

Theatre Theatre related sites

Visual Arts
Visual Arts related sites. Sites selling Art should be
submitted to the Consumer Products − Arts/crafts category.

Automotive

Category Name Type of sites accepted

Accessories /
Spares

Automotive accessories and spare parts sales

Auto Clubs Auto / car club sites

Aviation
Aviation related sites. Aviation sites specific to the tourism
industry should be submitted to the Travel − Airlines
category.

Cars
Car related sites. Car dealers should submit to the Automotive
− Dealers category.

Dealers Car dealer/sales sites

Category Descriptions 31



General Automotive related sites not covered by any other categories

History Automotive history sites

Insurance Automotive insurance products and services

Manufacturers Automotive manufacturer sites

Motorbikes and
scooters

Motorbike/scooter related sites

Rental Cars Rental car services

Services Other automotive services not covered by any other categories

Trucks and vans Trucks and van related sites

Business and services

Category Name Type of sites accepted

Accounting Sites promoting accounting services

Advertising/Marketing Sites promoting advertising and marketing services

Announcements Announcement services

Agriculture Agriculture related services

Banking

Banking related services. Mortgage related sites should
be submitted to the Real Estate − Mortgage category.
Sites promoting mortgage services should be submitted
to the Real Estate − Mortgages category

Building Building services

Business to Business Business services for other businesses (B2B)

Charities Charities

Classifieds Sites offering classified ad services

Cleaning Cleaning services

Communications
Communications services. Mobile phone related sites
should be submitted to the Electronics − Mobile phones
category.

Conferences and
Meetings

Sites offering conference and/or meeting
facilities/services

Consultants Business consultant services

Courier Courier services

Dating agencies Dating services

Electrical services Electrical services / electricians

General business General business services not covered by any other
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services categories.

Graphic Design Graphic Design services

Import Export Import / Export services

Industrial Goods Industrial goods related sites

Investigation Investigative services

Legal Sites offering legal information.

Logistics Logistics services

Mail Order Mail order sales

MLM
MLM (Multi Level Marketing) sites. Also known as
Network Marketing.

Opportunities
Work from home / business for sale / franchise
opportunities

Organizations Organizations. eg. Non profit, community

Other services
Other services not covered by other categories. Business
services should be submitted to the Business services
category

Photography Photography services

Plumbing Plumbing services / plumbers

Printing Printing services

Quality Control Quality Control services

Resources Business resource information

Restaurants/cafes
Restaurants, cafes and food services. Recipe and cooking
related sites should be submitted to the Entertainment
and recreation − Eating/drinking category

Scientific consultants
Science/technology consultants. Internet/computer
consultant sites should be submitted to the Internet −
consultants or Computer − consultants categories.

Science services Science related services

Security Security services

Spiritual Spiritual services

Veterinary Veterinary services / vets

Wholesale Wholesale services
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Computing

Category
Name

Type of sites accepted

Books Computer related books

Computer
consultants

Computer consulting services

Dealers and
shops

Computer dealers / shops

Games
Computer game related. Gambling games should be submitted
to the Entertainment − gambling category.

General Other computer related sites not covered by any other categories

Hacking
Phreaking

Hacking / phreaking related sites

Hardware Computer hardware

Multimedia Computer multimedia

Networking Computer networking related sites

Other services Other computer services not covered by any other categories

Security Computer security related sites

Software
Computer software. Sites promoting Internet related software
should be submitted to the Internet − software category.

Training
Computer training services. Sites promoting Internet related
training should be submitted to the Internet − Training category.

Consumer Products and shopping

Category Name Type of sites accepted

Antiques Antique products

Arts/Craft Arts/craft products

Beauty Beauty related products

Books Books

CDs
CDs sales. Sites selling music CDs should submitted to the
Music CD category

Clothing Clothing related products

DVDs
DVD sales. Sites selling music DVDs should submitted to the
Music DVD category

Electrical /
appliances

Electrical products. Computer related products should be
submitted to the Computer categories.
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Fashion Fashion products

Food Food and drink products

Furnishings Furnishing related products eg. furniture,curtains,carpets.

Gardening Garden products eg. plants, shovels, gloves.

General Other products not covered by any other categories

Gifts/flowers Gifts / flowers

Health
Health related products. Sites promoting Drugs/medicines
should be submitted to the Health − medicine category

Jewelry Jewelry

Music CDs Music CD's

Music DVDs Music DVD's

Office
Equipment

Office Equipment related services

Office Supplies Office supplies

Office furniture Office furniture

Online Store
Online stores e.g. sites that allow purchase online. Select this
category if there are no specific categories for your store listed
in this category section

Toys/Novelties
Toys and other novelty/entertainment products. Adult related
products must be submitted to the Adult − Merchandise &
Equipment category

Education

Category Name Type of sites accepted

Adult Education Adult education services

Distance Distance education services

High School High schools

Preschool Preschool services

Schools School sites

Services
Other education services not covered by any other
categories

Supplies Educational supplies

Universities/CollegesUniversity and College sites

Other
Other education related sites not covered by any other
categories
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Electronics

Category Name Type of sites accepted

Audio and Hi−fi Audio and hi−fi equipment sales, information and services

Mobile Phone Mobile Phone sales and services (including ringtones)

Television
Television sales/services/information. Sites related to
television programs should be submitted to the
Entertainment − Television category.

Radio
Radio sales/services/information. Sites related to radio
programs should be submitted to the Media − radio
category

PDA
PDA (Personal Digital Assistant) sales/service/information.
eg. Pocket PC, Palm devices.

WAP WAP (Wireless Application Protocol) services/information

Other
Other electronics related sites not covered by any other
categories

Telecommunications

Telecommunications related sites. Sites selling or servicing
radios or Mobile phones should be submitted to
Electronics/Mobile Phones and Electronics/radio categories
respectively.

Employment

Category
Name

Type of sites accepted

Agencies Employment agencies/recruitment services

General
Other employment related sites not covered by any other categories.
Work at home and other "opportunity" related sites should be
submitted to the Business and services − Opportunities category.

Positions
Vacant

Employment vacancies / job offers. Work at home and other
"opportunity" related sites should be submitted to the Business and
services − Opportunities category.

Job site Job sites listing multiple vacancies eg. http://www.seek.com.au

Entertainment and recreation

Category Name Type of sites accepted

Amusement
Parks

Amusement Parks

Books
Books reviews/discussions. Sites selling books should be
submitted to the Consumer products − books category

Celebrities Celebrity related sites
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Cinema Cinema related sites

Eating/Drinking

Recipe and cooking related sites. Sites promoting food and
drink products should be submitted to the Consumer products −
Food category. Restaurant/cafe/food service sites should be
submitted to the Business and services − Restaurants/cafe
category

Exhibitions Exhibitions and shows

Gambling −
offline

Gambling/betting/lottery sites that do not offer an online
gambling service. This includes sites containing gambling
tips/rules/information/bots etc.

Gambling −
online

Gambling/betting/lottery sites that offer an online gambling
service

Games

Games related sites. Computer game related sites should be
submitted to the Computer − Games category. Gambling
related sites should be submitted to the Entertainment −
Gambling category

Gardening
Hobby gardening related sites. Sites promoting gardening
products should be submitted to the Consumer products −
Gardening category

General
Other entertainment related sites not covered by any other
categories

Hobbies Hobbies

House and home
House and home related sites. Sites promoting products should
be submitted to the Consumer products category

Humor Humor/comedy related sites

Magazines
Magazine discussion. Sites promoting magazines should be
submitted to the Media − Magazines category

Magic
Magic shows/services. Sites discussing magic should be
submitted to the Paranormal − Magic category

Music

Music entertainment related sites. Sites promoting music
products should be submitted to the Music/CD's or Music
DVD's category. Sites about music as a hobby should be
submitted to Arts and Humanities − music category.

Outdoors Outdoor activity sites

People and
society

Sites about people and society. Celebrity related sites should be
submitted to the Entertainment − Celebrities category.

Pets/Animals Pets/Animal sites

Television/Radio
Television/radio related sites. Sites selling or servicing
televisions/radios should be submitted to the Electronics −
Television or Electronics − Radio categories.
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Finance

Category
Name

Type of sites accepted

Accounting
Accounting related sites. Sites promoting accounting services
should be submitted to the Business and services − Accounting
category.

Banking
Banking related sites. Sites promoting banking services should be
submitted to the Business and services − Banking category.

General Other finance related sites not covered by any other categories .

Insurance
Insurance related sites. Sites promoting vehicle insurance services
should be submitted to the Automotive − Insurance category.

Investments Investment related sites.

Loans/Credit
Loans/Credit related sites. Sites promoting mortgage services
should be submitted to the Real Estate − Mortgages category.

Mortgages
Mortgage related sites. Sites promoting mortgage services should
be submitted to the Real Estate − Mortgages category

Stock Market Stock Market related services

Health / Medical

Category
Name

Type of sites accepted

Alternative
Medicine

Alternative Medicine related sites

Disabilities Disability related sites

Diseases and
illnesses

Disease related sites. Sites promoting medicine/drugs should be
submitted to the Health − Medicine category. Sites promoting
health products should be submitted to the Consumer products −
Health category.

Fitness

Fitness related sites. Sites promoting health products should be
submitted to the Consumer products − Health category. Sites
promoting medicine/drugs should be submitted to the Health −
Medicine category.

Hospitals Hospital sites

Massage Massage services

Medical
Centers

Medical Centers

Medicine
Medicine/drug related sites. Sites promoting health products
should be submitted to the Consumer products − Health category.
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Mental
Health

Mental Health related sites. Sites promoting psychology services
should be submitted to the psychology category.

Optical Optical services

Other
services

Other health and medical services not covered by other categories.

Psychology Psychology related sites.

Nursing
Homes

Nursing Homes

Nursing
services

Nursing services

Nutrition Nutrition related sites

Supplies

Other health/medical supply related sites. Sites promoting health
products should be submitted to the Consumer products − Health
category. Sites promoting medicine/drugs should be submitted to
the Health − Medicine category.

Industry

Category
Name

Type of sites accepted

Agriculture
Agriculture industry related sites. Sites promoting agricultural
services should be submitted to the Business and services−
Agriculture category.

Chemicals Chemical industry related sites.

Construction
Construction industry related sites. Sites promoting building
services should be submitted to the Business and services −
Building category.

Electronics

Electronics industry related sites. Sites promoting electrical
products/services should be submitted to the Electronics
category or the Consumer products − Electrical / appliances
category.

Food

Food industry related sites. Sites promoting food/drink products
should be submitted to the Consumer Products − Food category.
Sites promoting Restaurants, cafes and food services should be
submitted to the Business and services− Restaurants category.
Recipe and cooking related sites should be submitted to the
Entertainment and Recreation − Eating/drinking category

Gas Gas industry related sites

Machinery Machinery industry related sites

Manufacturing Manufacturing industry related sites

Metals Metal industry related sites
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Mining Mining industry related sites

Oil Oil industry related sites

Pharmaceuticals

Pharmaceuticals manufacturing industry related sites. Sites
promoting health products should be submitted to the Consumer
products − Health category. Sites promoting medicine/drugs
should be submitted to the Health − Medicine category.

Plastics Plastic industry related sites

Petrochemicals Petrochemical industry related sites

Rubber Rubber industry related sites

Textiles
Textile industry related sites. Sites promoting clothing/textile
products should be submitted to the Consumer Products −
Clothing category.

Internet

Category
Name

Type of sites accepted

Access
Providers

Internet Access providers. This is for sites that offer Internet access
only (eg. an IP address only), not other services such as email,
support, newsgroups etc. Sites promoting ISP services should be
submitted to the Internet − ISP's category.

Internet
consultants

Internet consultant services.

General

Other Internet related sites not covered by any other categories.
Personal home pages should be submitted to the Personal Home
Pages category. Online stores should be submitted to the Internet −
Online Store category.

ISPs ISP (Internet Service Provider) sites

Promotion
and SEO

Web site promotion and SEO related sites

Resources
Internet resources. eg. Script archives, image archives, information
about the Internet, tutorials etc.

Search
Engines

Search Engines eg. http://www.google.com. NOTE: This category
is for sites that ARE search engines.

Software
Internet software related sites. Sites promoting software not related
to the Internet should be submitted to the Computer − Software
category.

Training
Internet training services. Sites promoting non−Internet related
computer training should be submitted to the Computer − Training
category.
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Web site
hosting

Web site/hosting/domain services. Sites promoting Web site design
services should be submitted to the Internet − Web site design
category.

Web site
design

Web site design services/information

Media

Category Name Type of sites accepted

Advertising/AgenciesMedia agencies

Consultants Media consulting services.

Film
Film industry related sites. Sites discussing films, reviews
etc. should be submitted to the Entertainment − cinema
category.

Newspapers Newspaper sites

Magazines
Magazine sites. Sites discussing magazines, reviews etc.
should be submitted to the Entertainment − Magazines
category.

Productions
Media production sites. eg. Music/video/tv/radio
production services.

Public Relations Public Relations sites

Publishing Publishing related sites

Radio

Radio industry. Sites selling or servicing radios should be
submitted to the Electronics − Radio category. Sites
discussing radio programs for entertainment purposes
should be submitted to the Entertainment −
Television/Radio category.

Services
Other media related sites not covered by any other
categories.

Television

Television industry. Sites selling or servicing Televisions
should be submitted to Electronics/Televisions category.
Sites discussing Television programs for entertainment
purposes should be submitted to the Entertainment −
Television/Radio category

Video Video industry.

Music

Category Name Type of sites accepted

Asian Asian music sites

Blues and roots Blues and roots music sites

Classical Classical music sites
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Country Country music sites

Fan sites Band/artist fan and information sites

General Other music sites not covered by any other categories

Gospel Gospel music sites

Heavy Metal Heavy Metal music sites

Hip hop Hip hop music sites

Instrumental Instrumental music sites

Jazz Jazz music sites

Latin Latin music sites

MP3 MP3 related sites

Musical Instruments Musical Instruments

New Age New age music sites

Opera Opera related sites

Pop Pop music sites

Rock Rock music sites

Soul Soul music sites

Techno Techno /electronic music sites

World Music World music sites

Paranormal

Category Name Type of sites accepted

ESP ESP (Extra Sensory Perception)

Fairy
Appreciation

Fairy related sites

Ghosts Ghost related sites

Kryptozoology Kryptozoology sites

Magik
Magik sites. Sites promoting a magic service/show should be
submitted to the Entertainment/Magic category.

Parapsychology Parapsychology sites

Spectrology Spectrology sites

Telekinesis Telekinesis sites

UFOs UFO (Unidentified Flying Object) sites
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Personal Home page

Category
Name

Type of sites accepted

Personal
Home page

Personal sites only. eg. Sites about John Smith, John Smith's
dog/family/hobbies. Commercial sites not permitted.

Family Tree Family tree / Genealogy sites

Politics/Government

Category
Name

Type of sites accepted

City City level of politics/government

Consultants Political/government consultants

County County level of politics/government

Embassies Embassies

Federal Federal level of politics/government

General
General political/government related sites not covered by any other
categories

Legislative Legislative related sites

Military Military sites

Other
Other political/government related sites not covered by any other
categories

Provincial Provincial level of politics/government

Regulatory Governmental Regulatory sites

Services Political/government services

State State level of politics/government

Tax
Tax information. Sites promoting accounting/tax services should
be submitted to the Business and services− Accounting category

Real Estate

Category
Name

Type of sites accepted

Agents Real estate agents

Architecture Architects/architecture

Brokers Real estate brokers
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Builders
Building/construction information. Sites promoting building
services should be submitted to the Business and services −
building category

General Other real estate related sites not covered by any other categories

Mortgages Mortgage/home loan products and services

Properties Properties for sale

Rentals Rental properties

Repair Repair services

Surveying Surveying services

Services
Other Real estate related services not covered by any other
categories

Reference

Category
Name

Type of sites accepted

Directory
Directories eg. http://dmoz.org NOTE: This category is for sites
that ARE directories.

Encyclopedia Encyclopedias

Libraries Libraries

Other Other reference related sites not covered by other categories

Weather Weather information

Religion

Category Name Type of sites accepted

Churches Church sites

Experiences Religious experiences

News Religious news

Other Other religion related sites not covered by other categories

Philosophy Philosophy sites

Services Religious services

Supplies Religion related products

Science & Technology

Category Name Type of sites accepted

Agriculture Agricultural science related sites. Sites promoting agricultural
services should be submitted to the Business and services −
agriculture category. Sites related to the agricultural industry
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should be submitted to the Industry − agriculture category.

Biotechnology Biotechnology sites

Chemistry
Chemistry sites. Sites related to the chemical industry should
be submitted to the Industry − chemicals category.

Engineering Engineering sites

General General science sites not covered by other categories

Geography Geography sites

Mathematics
Mathematics sites. Sites promoting Mathematics software
should be submitted to the Computer − software category.

Medicine
Medical science related sites. Sites promoting medicine/drugs
should be submitted to the Health − medicine category.

Other Other science sites not covered by other categories

Paleontology Paleontology sites

Physics Physics sites

Research Scientific Research sites

Science Science sites

Space/AstronomySpace/Astronomy sites

Sports

Category
Name

Type of sites accepted

Athletics
Athletics sites. Sites promoting health products for athletes
should be submitted to the Health − medicine category.

Billiards Billiards sites

Badminton Badminton sites

Basketball Basketball sites

Baseball Baseball sites

Boating Boating related sites

Bowling Bowling

Chess Chess sites

Cycling Cycling sites

Equestrian Equestrian sites

Extreme SportsExtreme Sports sites

Fishing Fishing sites
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Flying Flying/recreational aviation sites

Football Football sites

Formula 1 Formula 1 sites

Gymnastics Gymnastics sites

Golf Golf sites

Handball Handball sites

Hockey Hockey sites

Ice Skating Ice Skating sites

Martial Arts Martial Arts sites

Motor Sport
Motor Sport sites. Sites promoting automotive products and/or
services should be submitted to the Automotive categories.

Olympics Olympics sites

Other Other sports sites not covered by other categories

Para Gliding Para Gliding and other aerial flight related sites

Rugby Rugby sites

Skateboarding Skateboarding sites

Skating Skating sites

Skiing Skiing sites

Snowboarding Snowboarding sites

Softball Softball sites

Soccer Soccer sites

Surfing Surfing sites

Table Tennis Table Tennis sites

Tennis Tennis sites

Shooting Shooting sites

Squash Squash sites

Swimming Swimming sites

US Football US Football sites

Volleyball Volleyball sites

Wrestling Wrestling sites

Water Sports Water Sports sites
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Travel

Category Name Type of sites accepted

Activities Travel related activities

Airlines Airline sites

Car Rentals Car Rentals specifically for tourists/tourism

Cruises Sites promoting cruises

General
General travel related sites not covered by other
categories

Holidays Sites promoting holidays

Hotels/AccommodationHotels/Accommodation sites

Hot Springs Hot Springs

Tourist Info Tourist Information

Tours Sites promoting tours

Transport Transport sites related to the Travel/tourism industry

Travel Agencies Travel agency sites
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Submission Wizard

Please read the Submission rules and frequently asked questions BEFORE submitting your
site. The information in these sections may prevent your site from being banned from the
search engines.

To start the submission wizard, click the Wizard button on the toolbar. You can also start the
Wizard via the Window menu.

Enter a URL

Enter the URL to submit.
Most engines specifically request that only the index page of the site is submitted. eg.
http://www.example.com

Submitting multiple pages from the same URL is regarded as spamming the search
engines.
For example, http://www.example.com/page1.html,
http://www.example.com/page2.html, http://www.example.com/page3.html etc
The search engines will spider (crawl through all the pages on your site) and index
the pages automatically.

To add the URL to the current project, select the first option.
To create a new project, select the second option.

Click the Next button to continue.

1. 
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Enter the URL details

Enter the URL title, brief description and long description.

To import this information from a URL's meta tags, click the Import button and enter
the URL to import from.

The title should be a brief one line description that summarizes the page or its
content. Avoid using the URL or keywords as a title.

◊ 

The brief description should be a one line description (250 chars or less) that
summarizes the page or its content.

◊ 

The long description should be a longer description (500 chars or less) that
summarizes the page or its content.

◊ 

For a description of each field, see the URL details section.

Click the Next button to continue.

2. 
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Enter site and login details

Select a site type from the list.

Select Commercial if your site is business related or is selling or promoting a
product and/or service.

◊ 

If your site is not commercial in nature, select the non−commercial option.◊ 

If your site is promoting MLM (Multi level marketing − also known as
network marketing) select the MLM option.

◊ 

If your site is gambling related i.e. casino, bots, online gambling, gambling
tips, betting etc. select the Gambling option

◊ 

If your site is adult related i.e. sex, nudity, pornography, promoting adult
products and/or services etc. select the Adult option.

◊ 

Select the main language used on the site from the language field.

Enter a username and password for your submission. Some engines require this
information and it can be used to edit a listing on a search engine at a later date.

Click the Next button to continue.

3. 
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Enter keywords for the URL

Enter up to 15 keywords, with the most important keywords listed first.

To import keywords from a URL's meta tags, click the Import button and enter a
URL.

Click the Next button to continue.

4. 
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Enter submission email address(es)5. 

Enter a valid email address in the Email field.

Most engines require an email address to be entered as a requirement of submission.
The email address may appear in the listing on some directories. An invalid email
address may result in the site not being indexed. We recommend creating a yahoo,
hotmail, gmail or other free web based email account for use with submissions. Some
engines send a confirmation email, and if a response is not received, then your site
will not be listed.

You may use a different email address for the engines that send confirmation emails.
Enter the email address in the Confirmation email field. Even if a confirmations email
is entered, it is advisable to check both emails accounts to ensure that any stray
confirmation emails are replied to.

Click the Next button to continue.
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Select a category

Select the most appropriate category for your site. A brief description of each
category along with category selection guidelines is available in the category
description section of the manual.

The most relevant category should be listed first, as this category will be used for
submissions. If an engine does not accept submissions in the top category, the next
category in the list will be used, and so on.

Click the Next button to continue.

6. 
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Enter contact details

Enter the contact details for your submission. Some directories will display this
information in your listing. Compulsory fields are listed in red.

Click the Next button to continue.

7. 
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Select engines for submission

Select the engines to submit your site to. To submit to all the available engines, click
the Select All button.

Tick the "show FFA link sites" to display the FFA/link list sites. This option is not
recommended. A link list (or Free For All) is a web page that contains a list of links
to web sites. The link list can hold a specific number of links. When this limit is
reached and a new link is submitted, the oldest link drops off the list. In return for
listing your link, the link list owner will send advertising emails promoting their
products/services to your email address.

Click the Next button to continue.

8. 

Acceptable use policy

The acceptable use policy will then be displayed. Please take the time to read this, as
improper use of SubmitWolf may result in your licence being suspended.

Click the OK button to continue or cancel to revise the submission.

9. 
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Spam warning

If you have selected engines that send a large number of emails to the submission
address, the spam warning will be displayed.

Click the Cancel button to go back and change the engine selection. Click the OK
button to continue with the submission.

10. 

License and engine update check

SubmitWolf will then contact the upgrade server to check that the latest engine
updates have been installed.

11. 
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If you are using the non enterprise version of SubmitWolf you will be prompted to
use one of the domain licences for the submission. You can use up to 5 different
domains with the non enterprise version.

Submission complete!

SubmitWolf will submit your site, and display the connection status window. For
more information about this window, see the Connection status section of the manual.

12. 
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After submission, SubmitWolf will display selection of submission reports that you
can view.

Submission results − displays the engine list with the submission date,
number of submissions and submission status fields e.g. submitted, failed,
skipped etc.

◊ 

Report − displays custom report builder with the options of displaying the
submission details, submitted engine status, and/or the full engine report.

Select the reports to view, then click the Finish button. The report details are
described in the Reporting and maintenance section of the manual.

◊ 
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Importing previous SubmitWolf projects

SubmitWolf 7 will try to import projects from older versions automatically.

Projects can be manually imported by clicking on the File menu and selecting the Import
menu option.

Change the file type to SubmitWolf projects, locate the project to import then click the Open
button.

The default projects folder for SubmitWolf 6 is
C:\Program Files\TRELLIAN\SubmitWolf v6.0\Projects

The default projects folder for Submitwolf 5 is
C:\Program Files\TRELLIAN\SubmitWolf PRO v5.0\Projects
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SubmitWolf 7 requires more information than the previous versions, of submitWolf, therefore
some fields may be blank after importing a project.
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Submitting a URL

There are two ways to submit a URL. The submission wizard is an easy to use tool that walks
through each step of the submission process.
For advanced users, SubmitWolf offers an interface similar to the previous SubmitWolf
versions. The next section covers submission via the advanced interface.

Note: Non enterprise users are limited to 5 different domains for submission. If you wish to
submit more than 5 different domains, you will need to upgrade to the enterprise version
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Entering a URL

Please read the Submission rules and frequently asked questions BEFORE submitting your
site. The information in these sections may prevent your site from being banned from the
search engines.

To submit a new URL, click either of the "New URL" buttons.1. 

Enter the URL, including the http://

Most engines specifically request that only the index page of the site is submitted. eg.
http://www.example.com

2. 
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Submitting multiple pages from the same URL is regarded as spamming the search
engines. The search engines will spider (crawl through all the pages on your site) and
index the pages automatically.

An "i" symbol will appear next to a URL if the URL is missing information required for
submission. For example, the symbol will appear if one or more of the compulsory fields is
incomplete and/or the URL has no engines selected for submission.
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Entering URL details

The next step is to enter as much information as possible about the web site you are
submitting. Click the details button to enter URL details.

Below is an example showing the data entered for the details window.
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Red field labels indicate a compulsory field, all other fields can be left blank if not
appropriate. See the table below for a description of each field.

Field: Description:

URL Title
This should be a brief one line description that
summarizes the page or its content. Avoid using the
URL or keywords as a title.

URL
The URL field should already contain the URL to
submit.

Site Type Some search engines only accept specific types of
sites. Selecting the appropriate site type will ensure
that your site is submitted to relevant search engines.

Commercial − if your site is
business related or is selling or
promoting a product and/or service.

Non commercial −If your site is not
commercial in nature, select the
non−commercial option.
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MLM − If your site is promoting
MLM (Multi level marketing − also
known as network marketing) select
the MLM option.

Gambling − If your site is gambling
related i.e. casino, bots, online
gambling, gambling tips, betting etc.
select the Gambling option

Adult / sex − If your site is adult
related i.e. sex, nudity, pornography,
promoting adult products and/or
services etc. select the Adult option.

Category For the most appropriate placement in directories and
specialty search engines, you need to categorize your
web page.
You can select multiple categories for your site,
however SubmitWolf will select the category at the
top of the list when submitting. If the top category is
not supported by an engine, SubmitWolf will then
select the next category on the list, and so on.

To view a description of each category, see the
Category description section of this manual.

Please ensure that the MOST appropriate category is
the first one you select. This is important because
some directories will only list your URL once, in a
single category.

Note: ONLY submit your web site to categories that
are appropriate and relevant to your web site.
Submitting to categories not related to the web site is
contrary to the SubmitWolf acceptable use policy,
and can result in your submissions being banned
from some engines.

Language Select the primary language of your site.

Username Some engines require you to specify a username and
password. This username and password is required to
make subsequent changes to your listing.

Both the username and password should be 6
characters long and contain no spaces or punctuation
characters.

Note: Do NOT use your ISP logon password or your
SubmitWolf registration details in these fields.
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Password Some engines require you to specify a username and
password. This username and password is required to
make subsequent changes to your listing.

Both the username and password should be 6
characters long and contain no spaces or punctuation
characters.

Note: Do NOT use your ISP logon password or your
SubmitWolf registration details in these fields.

Keywords Enter a list of keywords relevant to your web page.
Click the >> button to edit your keywords using the
Keyword Manager. List the most relevant keywords
first as some engines will only use the first 10
keywords.

Some engines use META tags to obtain the keyword
list for the page, and ignore this field. You should
ensure that your keywords are also present in your
META tags. You can use the Meta Tags editor for
this purpose.

Description
(brief)

Enter a short description of your website. (250
characters or less)

Note: The search results of most engines will only
display a short extract. Usually, the extract is
composed from the first few lines of your description.
It is thus a good idea to keep the description brief and
ensure that the most relevant information is
contained in the first few lines.

Some engines use META tags to obtain the
description and extract, and will ignore this field. You
should thus ensure that your description is also
present in your page as a META tag. You can use the
Meta Tags editor for this purpose

Description
(long)

Enter a longer description of your website. (500
characters or less)

Note: The search results of most engines will only
display a short extract. Usually, the extract is
composed from the first few lines of your description.
It is thus a good idea to keep the description brief and
ensure that the most relevant information is
contained in the first few lines.

Some engines use META tags to obtain the
description and extract, and will ignore this field. You
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should thus ensure that your description is also
present in your page as a META tag. You can use the
Meta Tags editor for this purpose

Company
Enter your company name. If your site is non
commercial (personal homepage or information
website) leave the company field blank.

First Name First name of the site owner/webmaster/submitter.

Surname Surname of the site owner/webmaster/submitter.

Title Title of the site owner/webmaster/submitter.

Email Ensure that you enter a valid email address as some
engines will reject submissions with invalid email
addresses.

Some engines will send indexing/listing notifications
to this address.

A free based email address, such as hotmail, yahoo or
gmail is recommended. Note: Some directories may
use the email address as part of the URL listing.

Confirm

Some engines will send a confirmation email that
requires an action to be performed in order for the site
to be listed/indexed. Confirmation emails will be sent
to the confirm email, if entered.

Street

Enter your street number and name. Note: This may
appear in the listings. You can put a dash or n/a in the
field, however some engines will not accept the
submission without an address.

City
Enter your City name. Note: Some directories may
classify your listing based on locality, and may use
this field.

State
Enter your state name. Some directories may classify
your listing based on region, and may require/use this
field.

State Code
Enter the State Code. e.g. DC, VIC etc. If not
appropriate, leave this field blank.

Zip Enter your ZIP or Post Code.

Country
Enter the website's country of origin. Some search
engines/directories will use this field to determine the
category/section that your site will be listed in.

Tel Enter your telephone number. On some directories
the telephone number may appear as part of your
listing.
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This field is optional, however some directories may
not list your site without a valid phone number.

Fax
Enter your fax number. On some directories the fax
number may appear as part of your listing.
this field is optional.

Toll Free

Enter your toll free phone number. On some
directories the toll free number may appear as part of
your listing.
This field is optional.
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Importing URL and contact details

SubmitWolf features helpful functions to import URL details and to load previously saved
contact detail sets. This significantly speeds up the data entry process so that only the site
type, category and language fields require manual input.

Importing URL details

To import a URL's details, such as title, description, keyword etc, directly from the URL,
click the Import button on the details window.

The wizard will step through the import process, and populate the relevant fields in the URL
details window.
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Importing contact details

Contact details can be saved and imported to allow for quick data entry. Generally this
function would be used by Enterprise users, who are submitting websites on behalf of clients.

To use this function, a set of contact details must first be saved. To save the contact details,
ensure that the relevant fields are filled out. This function will save the following field data:

Company♦ 
First Name♦ 
Surname♦ 
Title♦ 
Email♦ 
Confirm♦ 
Street♦ 
City♦ 
State♦ 
State code♦ 
Zip♦ 
Country♦ 
Tel♦ 
Fax♦ 
Mobile♦ 
Toll Free♦ 
Username♦ 
Password♦ 
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Then click on the Contact details menu, and select Save.

Enter a filename to complete the save process.

To load the contact details, enter the new URL and click on the details tab. Click on the
Contact details menu and select Load.
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The Contact details will be loaded into the URL details window. Any existing data will be
overwritten.
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Search engine selection

To select search engines for submission, click the Engines button on either the main
toolkit window or on the URL details window. The URL, language and country fields
must be filled in prior to engine selection.

1. 

If you have selected a country for which you do not have an engine subscription, a
warning message will be displayed.
To install the engines, click the Yes button. Click No if you do not want to install the
engines.

2. 
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You will be presented with a list of engines in your subscription that will accept your
URL, based on the details you have entered. To change your engine subscription,
click the Subscribe button

Some engines may not be selectable. SubmitWolf will automatically determine which
engines are not appropriate for your site.
eg. If your site is not commercial, then all commercial based engines will be
unavailable for selection. If your site is not Travel related, all Travel search engines
will be unavailable for selection. etc..

3. 
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The engines are divided into a number of categories. These are accessed via the
folders on the left hand side. Engines in each category can be selected separately. The
Engines folder contains all automated search engines and directories.

Image: Category: Description:

Search
engines

These engines are search engines and
are located in the Engines folder

Directory
These engines are directories and are
located in the Engines folder

Link Lists These sites are link lists (FFA) sites. A
link list is a web page that contains a
list of links to web sites. The link list
can hold a specific number of links.
When this limit is reached and a new
link is submitted, the oldest link drops
off the list. In return for listing your
link, the link list owner will send
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advertising emails (spam) to your email
address. Link list submission is not
recommended. Link lists are found in
the Link Lists folder

Multi
Submit

A single submission to a multisubmit
engine results in the URL being
submitted to multiple FFA sites. This
option is not recommended. Multi
Submit engines are found in the Multi
Submit folder

Manual
Sites

These are sites for which SubmitWolf
does not have an automated submission
script. This is either because it is too
difficult to create such a script, the site
is too specialized, or a script has not yet
been written and may be available in
the next upgrade. For manual
submission details see the Manual
submission section of the manual.
Manual Submission engines are found
in the Manual folder

Reciprocal

Reciprocal engines require a link on
your web site to the engine's web site
before they will list your site. For this
reason, the reciprocal engines are found
in the Manual folder

Shadow

Shadow engines are powered by a third
party indexes. For example, the AOL
search engine uses results from the
Google index. These engines are
marked as submitted when you submit
to their powering index.

There are several ways to select engines:

Selecting engines one at a time

To select the engines one at a time, simply tick the checkbox next to the engine(s)
you wish to submit your site to.

4. 

Search engine selection 79



Quick selection

Click the Select button (or use the Select menu) to specify the types of engines to
select for submission.

There are several different types of engines that can be selected:

True engines − These engines are search engines. Search engines do not
organize websites in category listings, rather they determine which websites
to display based on an entered search term. An example of a search engine is
Google. http://www.google.com

◊ 

Directories − A directory indexes websites by placing each site into a
particular category. A directory displays a list of the available categories, and
when a category is viewed, all the sites listed in the category are displayed.
Some directories also offer a search function. An example of a directory is
DMOZ at http://dmoz.org

◊ 

FFA pages − An FFA page (also known as a Free For All or link list) is a
web page that contains a list of links to web sites. The link list can hold a
specific number of links. When this limit is reached and a new link is

◊ 
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submitted, the oldest link drops off the list. In return for listing your link, the
link list owner will send advertising emails (spam) to your email address.
This option is not recommended.

Multisubmit − A single submission to a multisubmit engine results in the
URL being submitted to multiple FFA sites. This option is not recommended.

◊ 

Pending engines are engines that have not had a prior successful submission. To
select the pending engines, select the Pending ONLY option. To select all engines,
select the ALL option.

Setting default engines

To define a default selection of engines, select the engines that you wish to include in
the default setting.

Then click the Select menu and choose the Set Default option.

To apply the default engine selection, click the Select menu and choose the Default
option. A default button also appears in the Select button options.

When finished ...

Click the Submit button to begin the submission process.
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Submission confirmation

You should now be ready to submit your URL.

Check submission details
Check that the submission details are correct, as this is the final opportunity to change
this information.

Ensure that you are connected to the internet, and click the Submit button.

1. 

Acceptable use policy
The Acceptable use policy will be displayed. Please read the policy and check that
your submission will not violate any of the conditions listed.

2. 

Spam warning
If you have selected engines that send a large number of emails to the submission
address, the spam warning will be displayed.

3. 
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Click the Cancel button to go back and change the engine selection. Click the OK
button to continue with the submission.

License and engine update check
SubmitWolf will then contact the upgrade server to check that the latest engine
updates have been installed.

If you are using the non enterprise version of SubmitWolf, you will be prompted to
use one of the domain licences for the submission. You can use up to 5 different
domains with the non enterprise version.

4. 

Connection status
The connection status window will show the status of the submission process. For
more information about the Connection status window, please see the Connection

5. 
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status section of the manual.

Submission completed
Depending on the speed of your Internet connection, and the number of engines
selected, the submission process should take between 2 to 10 minutes.

6. 
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Connection status

The Connection status window provides a visual feedback of the submission status. To view
the connection status window, click on the Window menu and select the Status menu item. To
cancel the submission, click the Stop button.

When the submission has finished, the connection status window will display "Submission
complete".

Advanced Connection Status view

An advanced view of the connection status can be viewed by resizing the connection status
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window. This will display the engines that are being contacted, the engines responding to the
contact, and the engines that have failed or are still yet to respond.

Connection status values

Pending:
Engines that have either not received a submission or are yet to respond.

Submitted:
Engines that have successfully received your submission.

Failed:
Engines that result in a submission failure. The engine may have an error on submission , eg.
server errors or database errors, they may have moved or removed their submission page
without warning, or they may be experiencing network problems. You can view the response
received by right clicking on the engine in the Engines window, and selecting the Response
menu item from the popup menu.

Skipped:
Engines that are not appropriate for the category or country that you selected are skipped.
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Idle:
The engine is either queued for submission and is simply waiting for a connection to become
available, or there is no response from the engine as yet.

Connecting:
This indicates that the engine has been contacted and an attempt to make a connection has
been initiated.

Connected:
This indicates that the engine has been contacted and has made a successful connection.

Resolved:
This indicates that the engine's domain name has been resolved to an IP address.

Timed Out:
This indicates that the engine has not responded, or has taken too long to respond.
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Submission status

A small icon next to each engine name indicates the submission status of that site. The
following key explains the meaning of each icon:

Icon: Meaning: Description:

Submitted The URL has been successfully submitted to the site

Pending A submission has not been made to this site.

Failed
A submission to the site failed or returned an error. The cause for the
failure may be provided in the engine response.

Moved
The response page of this site has moved and SubmitWolf has not been
able to determine whether the submission has failed or succeeded

Timeout
An attempt has been made to submit to the site, but the connection timed
out before the submission was complete.

Skipped The engine was not appropriate for the URL that was submitted.

Engine response

To view an engine's response page, right click the engine and select the Response menu
option. If the engine returned a response, a browser window will be opened, displaying the
engine's response to your submission. Useful information can be obtained for failed
submissions as the engine's often provide an error message. eg. URL title too long.
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Engine properties

The submission status of each engine can be modified. In the engine list, right click on the
engine, and select Properties from the popup menu. You can edit the submission status by
changing the relevant fields, or clicking the Mark button to add a current timestamp. The reset
button will reset the engine's submission status.
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Warning: when resetting the submission status for engines with the "No multiple postings"
rule, note that this will allow another submission to these engines. This will result in the
engine receiving multiple submissions of your URL, which may violate the engine's
submission rules and result in a ban of your URL.
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Manual submissions

SubmitWolf has several hundred engines in its database which are not able to be automated
(See the submission frequently asked questions for an explanation). These Engines are listed
inside the Manual Folder in engines selection window.

Follow the instructions below to submit to a manual engine:

Step 1.

From the Engines window click on the Manual folder. Right click on the engine to submit to,
and select Open from the popup menu. This will open a browser window displaying the
engine's submission page.

Step 2.

Enter your web site's information into the submission form and follow the submission
instructions. eg. enter security code etc.
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Step 3.

When the submission has been completed. mark the engine as submitted. To do this, right
click on the engine and select Mark as Submitted from the popup menu.

The engine will then display a green tick and a timestamp.
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Batch submissions

To perform a batch submission (to submit more than 1 URL at once) enter the URLs and their
details.

If any compulsory URL details have not been entered, or if there are no engines selected for
submission, an "i" symbol will appear next to the URL. URLs with missing information will
NOT be submitted if selected for batch submission.

Default engines
Default engines can be set in SubmitWolf, and the default selection can be applied to the
URLs to help speed up the submission process.
To define a default selection of engines, open the Engine selection window and select the
engines that you wish to include in the default setting.
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Click the Select menu and choose the Set Default option.

To apply the default engine selection after entering a new URL, right click the URL, and
choose the Select menu item. Click the Default button to select the default engines.

Submitting the URLs
To submit the URLs, hold down the control key while selecting each URL, then right click
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and select Submit. SubmitWolf will submit the URLs sequentially.
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Reporting and maintenance

SubmitWolf can generate different types of submission reports, and provides methods for
reporting non functioning engines and suggesting new engines.

These tools are described in the following manual sections.
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Reports

To create a report, open the engines window, click the Report menu and select Build report.
There are three different report sections that can be included in the report:

URL details − displays the details of the URL that was submitted.♦ 
Submitted engines summary − displays the engines that have been submitted to.♦ 
Engine report − displays a list of all engines and their submission status.♦ 

The build report window allows you to select which report sections to include.

The report will be displayed in a web browser window. For information about the Enterprise
reports, see the Enterprise features section of the manual.

Example of the URL details report section
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Example of the Submitted engines summary report section
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Example of the engines report section

Reports 100



Reports 101



Submission history

To view a URL's submission history, select the submission tool, right click on the URL and
select properties.

URL
The URL

URL title
The URL title

Submitted
The number of engines that have been submitted to successfully.

Failed
The number of engines to which submission failed.

Skipped
The number of engines to which submission was skipped.

Pending
The number of engines to which submission is pending. i.e. Engines that have not been
submitted to yet.

History
The submission history.
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Reporting non functioning engines

Non functioning engines can be reported directly to the support team via SubmitWolf. Prior
to reporting an engine, the engine's response should be viewed. A failed submission does not
always mean that the engine is not working. The failure may be due to the data that was
submitted. Some engines will return a response page that contains information about the
failure.

To view an engine's response page, right click the engine and select the Response menu
option. If the engine returned a response, a browser window will be opened, displaying the
engine's response to your submission. Useful information can be obtained for failed
submissions as the engine's often provide an error message. eg. URL title too long.

To report a non functioning engine, open the engines window and highlight the engine to
report. Click on the Options menu and select Report broken engine. You can also right click
on the engine, and select the Report broken engine option from the popup menu.

Enter a brief description of the problem, and click the submit button.
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The support team will review the report and make any changes as required.
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Suggesting new engines

New engines can be suggested to the support team via the Engines window. Click on the
Options menu and select Suggest new engine.

All suggestions are reviewed by the support team prior to inclusion.
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SubmitWolf Enterprise

SubmitWolf Enterprise allows submission of an unlimited number of URLs. SubmitWolf
Enterprise can be used to run a submission service, or to submit 3rd party URLS. Enterprise
users may wish to use the batch submission function to streamline submissions. See the Batch
submissions section of the manual for more information.
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Importing Data

SubmitWolf can build projects from data files created by external sources such as online
submission forms.

Importing Projects from the Clipboard
Form submissions (in the format described below) received via email, for example, can be
imported directly from the Windows clipboard. Copy the data from the email, then click on
the File menu and select Import Clipboard

The data will be entered as a new URL in the current project, with the relevant URL detail
fields populated.

Data file format
The output of the form must be decoded into a tagged file format with one field per line. This
is the default format of many available CGI scripts. eg: Formmail.

FIELD_NAME1=VALUE
FIELD_NAME2=VALUE

The following field name tags are recognized by SubmitWolf: Note that some fields require a
specific value eg. country, language, and category. A list of these values and/or a sample
HTML submission form using these values, can be obtained from support.

FIRST= First Name

SURNAME= Surname

TITLE= Title

COMPANY= Company name

STREET= Street Address

CITY= City

STATE= State

STATECODE= State code

ZIP= ZIP / post code

COUNTRY= Country. Country list available from support

TEL= Telephone

FAX= Fax

MOBILE= Mobile

TOLLFREE= Toll Free Number

EMAIL= Email Address

CONFIRM= Email Address for submission confirmations

URLTITLE= Title of Web Page
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CNTCODE= Country code eg. au or fr. List available from support

LANG=
The language used on the site. Language list available
from support

SDESCRIPTION=Brief Description

DESCRIPTION= Long Description

URL= Url

TYPEID=
Type of site. eg Commercial, non commercial. Value list
available from support

USERNAME= Username

PASSWORD= Passwords

KEYWORDS= CSV Keywords (eg: keyword1,keyword2)

Notes:

Each field name corresponds directly to an input field of SubmitWolf. The data must be on a
single line with the exception of the DESCRIPTION field which can span several lines. eg:

DESCRIPTION=Line 1
Line 2
Line 3
Line 4

The CATEGORY field must have a numerical value representing a code of one of the
SubmitWolf categories. These values can be found in the 'types.dat' file.
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Setting up an online submission form

SubmitWolf enterprise users may wish to use an online form to accept customer website
submission information.

To take submission orders online, a HTML form is required. A client based form submission
i.e. mailto is not recommended. For users not experienced in cgi programming, the Formmail
cgi−script is a free simple server side form processing script. The home page for the script
can be found by searching for Formmail on Google.

The form needs to have specific field names and values in order for SubmitWolf to use the
data.

Here is a sample section of a submission form:

You may wish to use JavaScript on your submission form to enforce the following rules:
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The Personal Home Pages category is NOT for commercial sites♦ 

All site types except non−commercial sites, MUST have a company name entered♦ 

All adult/sex related sites MUST be submitted to the adult categories♦ 

All gambling / betting sites must be submitted to the Entertainment − Gambling
category.

♦ 

All compulsory fields must contain data in order to perform a submission♦ 

Failing to abide be the SubmitWolf submission policy may result in your licence being
suspended or cancelled. It is advisable to check that a submission will not violate the policy
prior to submitting the site.

You may wish to display or link to the category descriptions on your submission page to
assist with correct category selection.

If you wish to use your own email address as the confirmation email, you can hard code your
email address as a hidden field on the form, or hard code it into the CGI script. The same
applies for any other fields, such as username/password.

To obtain HTML code for a submission form, contact Support.
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Exporting submission data

To export the submission data for a project in a CSV (comma separated values) file, ensure
that the URL is currently selected, open the engines window, click on the File menu and
select the Export item.
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Reports

To create a report, open the engines window, click the Report menu and select Build report.
There are three different report sections that can be included in the report:

URL details − displays the details of the URL that was submitted.♦ 
Submitted engines summary − displays the engines that have been submitted to.♦ 
Engine report − displays a list of all engines and their submission status.♦ 

Enterprise users can customize the report to include a company name, logo etc, to provide
your client with a more professional service.

The look and feel of the report can be changed and fully customized by modifying the HTML
code of the report.htm file in Template directory.

Note: Please note that you should have some knowledge of HTML before attempting to
modify files , and we recommend that you create a backup of template files before making any
changes.

Submitted engines summary report

An example of the engines summary report section:
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URL details report

An example of the URL details report section:
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